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*************************************** 

Between the Dashes 

by Curt B. Witcher 

*************************************** 

Another Family History Month is just hours away. Each year I am excited about all the program 

offerings of The Genealogy Center, and the possibilities of learning new things that help me do 

more and better research with my own family history. I hope you feel the same, and further, I hope 

you make the effort to attend at least several of the program offerings this month. A complete list 

is found further on in this ezine.  

 

Many are familiar with the phrase, “fill in between the dashes,” as a charge to family historians. It 

comes from what many see on ancestors’ tombstones below the name: A birth date followed by a 

dash, and finally a death date. Besides knowing where an ancestor is buried and when that person 

was born and died, many of us long to know the details of that person’s life "between the dashes." 

Indeed, I believe it is our responsibility as genealogists to fill in between the dashes of our 

ancestors’ lives. Doing this will not only give us a much better understanding of our past and those 

who came before us, it will likely help us avoid many brick-walls in our genealogical research.   

 

What was everyday life like when our grandparents were growing up? Did they go to school? What 

did grandpa study and learn? Did Grandma cook with her mother and grandmother on holidays? 

What was different about what our grandparents wore? What did “Sunday best” mean relative to 

clothes and dressing-up? How did their friends and neighbors react to and participate in the wars 

that happened during their younger years? What was a vacation like for them, and what did they 

worry about? Working to find answers to these and other questions does help “fill in between the 

dashes.” And it will bring our ancestors to life. 

 

The amazing numbers of programs being offered during Family History month are designed to help 



us think about research and resources in new and creative ways. They are crafted to reinforce the 

best practices in which we engage, as well as to challenge us to think about new approaches and even 

better practices. And they are designed to help us “fill in between the dashes.” 

 

Over the past couple of weeks I have had several opportunities to talk about how the study of 

geographic history and ethnic history can positively impact one’s family history investigations and 

pursuits. Knowing why particular groups of people settled in specific areas during a certain time 

period can tell us something about whence they came, what skills and trades they brought with 

them, why particular churches sprung to life, and what kinds of other organizations and institutions 

were organized. As an example, the book “Peopling Indiana: The Ethnic Experience” (977.2 P39) 

provides rich and detailed information about every ethnic group that “touched toe” in the Hoosier 

state. Articles detail where particular ethnic groups hailed from and specifically where they 

settled. They also talk about groups' employment activities and religious practices. This 

information, like much of what one finds when exploring the ethnic and geographic histories relative 

to one’s ancestors, will greatly assist one in filling in between the dashes. For those who are local, 

the Allen County Public Library has ten copies of this book - two in Genealogy and eight others 

throughout the system - some of which can be checked out with a valid ACPL card.  

 

During this Family History Month, please commit to doing things and participating in programs that 

will help you fill in between the dashes, that will help you bring your ancestors’ lives to light and to 

life! 

 

*************************************** 

Facebook.com for Genealogists 

by Dawne Slater-Putt, CG(sm)* 

*************************************** 

Four years ago for Family History Month, I wrote and presented a lecture titled “Facebook for 

Genealogists.” My handout gave thirty ways that a genealogist can use Facebook, including posting 

ancestral photos, posting memorials on deceased relatives’ birthdays or death anniversaries, 

communicating with family members who live at a distance, sending invitations to a family reunion, 

and finding or creating a family surname page. 

 

What I didn’t anticipate was the explosion of Facebook groups and specialty pages for all manner of 

genealogy interest groups. Today there is a Facebook page or group for probably every genealogy-

related special interest that you might have, from technology and DNA, to the geographic areas 

where your ancestors lived, ethnic groups and specific family names. Check out the variety in this 

list that is comprised of groups I belong to, as well as suggested groups that appeared on the side 

of my page: 

 

*Social Media for Genealogy 

*Adoptions-Adoptees and Birth Families 

*Technology for Genealogy 

*GeneaRVing 

*The NextGen Genealogy Network (“to foster the next generation’s interest in genealogy …”) 

*Indiana Genealogy 

*Benton County Arkansas Genealogy 



*War of 1812 Preserve the Pensions 

*Random Acts of Genealogical Kindness 

*German Genealogy 

*Australian Family History and Genealogy 

*Women During World War II 

*Researching the Forbidden (“a private group where you are encouraged to discuss the forbidden 

stories of your ancestors”) 

 

Katherine R. Willson has compiled a list of genealogy-related Facebook sites. It is available under 

the “Files” tab on the NextGen Genealogy Network page, if you happen to be a member. It also has 

been reprinted in a post on the “Not Quite Dunn” blog, 

http://waynegenweb.blogspot.com/2013/07/facebook-genealogy-sites-list-by.html. The list at the 

Not Quite Dunn site does not have page breaks, so it is a bit difficult to follow, but Katherine 

indicated in the comments area of the blog that she is willing to share the information with others 

who contact her. 

 

Many organizations and research facilities have their own Facebook pages, as well. The Genealogy 

Center’s page is www.Facebook.com/GenealogyCenter. Groups and pages work a bit differently. 

Individuals are “members” of groups and all may post status updates on the group’s page. Individuals 

“like” an organization’s page. They may post messages that appear on one side of the page and may 

comment on status updates, but on organization pages, only administrators may post status updates. 

 

Most group pages are “closed,” meaning that interested individuals click a button to send a request 

to join, and they are then approved and added by the administrator of the group. This isn’t to be 

exclusive toward anyone who has a legitimate interest in the group’s topic, but to keep out 

spammers who want to sell shoes, diet products and conduct other off-topic business on the site.  

 

Speaking of off-topic business, most groups will have a description of the group’s purpose or mission 

posted somewhere on the site, either “pinned” to the top of the news feed, or under the “About” 

tab at the top of the page. Group members are asked to stay on-topic. For example, the Technology 

for Genealogy group encourages discussions about the use of technology for research and related 

topics, but not queries about specific ancestors with no technology connection.  

 

If you are not yet on Facebook, or have not considered Facebook as a genealogy tool – perhaps now 

is the time. You can find answers to “how do I …?” technology questions, opinions on cloud storage or 

brands of portable scanners, find someone to do research legwork for you in your ancestors’ home 

county or give you information on records available in a distant courthouse, and maybe even find a 

cousin you have never met! 

 

*“CG” & “Certified Genealogist” are service marks of the Board for Certification of Genealogists, 

and are used by authorized associates following periodic, peer-reviewed competency evaluations. 

Certificate No. 386 awarded 4 July 1996; expires 4 July 2016. 

 

*************************************** 

“Upper Canada Gazette, Index to Personal Names, 1793-1798” 

by Cynthia Theusch 



*************************************** 

The “Upper Canada Gazette, Index to Personal Names, 1793-1798” is a book of newspaper 

abstracts on three microfiche sheets and can be found in The Genealogy Center in the Ontario 

section [Microfilm Cabinet H-1]. The full title of the source is “The Upper Canada Gazette (& 

American Oracle), Index to Personal Names 1793-1798.” It was compiled by Mary Kearns Trace. 

The author’s disclaimer indicates that she abstracted items only pertaining to North American 

residents and not individuals from other countries. The index includes about 4,600 names.  

 

Each index entry includes four components: Name, type of entry (there are 46 types), a brief 

abstract of the article, and the date of the newspaper, shown in parentheses. Some of the types of 

entries include advertisement (ADV), to be sold (TBS), immigrant arrival (IA), and married (M). 

Some examples are: 

 

Adams, George – ADV- wanting barks & hides for business at Queenston, also 14-18 yr old lad for 

apprentice to the tanning & currying business. April 22, 1795 (10 Jun 1795). 

 

Cozens, Sam. – TBS – see Heron, Sam. (01 Dec 1798) 

Heron, Sam. – TBS – James Ruggles & Sam. D. Cozens, exeors. at auction at Miles Tavern. Town of 

York, 26 Dec.  part of property of late John Lawrence – 228 Acres, E Side Humber, York Tp. etc. 

(01 Dec 1798) 

 

A complementary book in The Genealogy Center’s Canadian collection is “The Upper Canada 

Gazette,” by W. Craig Burtch (971.302 T63up). This book is divided in two parts. Volume 1 covers 

December 1796-December 1824 and includes The York Gazette, The York Weekly Post, and The 

York Weekly Register. Volume 2 covers January 1825-December 1829 and includes The York 

Weekly Register and The United Empire Loyalist. This index includes abstracts of births, marriages 

and obituaries, such as this example: 

 

Thursday, October 30, 1817, from The Upper Canada Gazette:  “Obit: In this Town on Tuesday, the 

28th inst., after a short but painful illness, which he bore with Christian fortitude and resignation, 

Mr. Thomas Shaw, lately from Ireland, brother to Mr. Joseph Shaw, Brewer, of this place, much 

lamented by his friends and relatives.” 

 

These two items are just a couple of examples of newspaper abstracts in the The Genealogy 

Center’s collection.   

 

*************************************** 

Technology Tip of the Month--Converting Multiple TIFFs to JPEGs, Part 2 – Adobe Elements 9 

by Kay Spears 

*************************************** 

Last month I covered converting multiple images using Adobe Photoshop. This month, I will be 

discussing the same thing for those who use the program Adobe Elements. I’m using Adobe 

Elements version 9, but the procedure should be similar for all Elements versions. You just might 

need to do a little searching to find the various terms. The phrase you should look for is Process 

Multiple Files. In version 9, this is in the File menu. 

  



As in the previous lesson, remember which folder your TIFF images are in and create a folder to 

which you will direct or send your JPG images. 

  

Go to File>Process Multiple Files. When you click on Process Multiple Files, a large dialog box will 

open. What we are interested in for this topic are Source, Destination and File Type. In the Source 

area, Browse to find the folder that contains the TIFF images you want to convert. Once you select 

the folder that has the image in it, that path will appear in your Source line. Next go to the 

Destination line and Browse. Select the folder that you created as the destination folder for the 

JPGs. That path will also appear on the Destination line. Then go down to the File Type>Convert 

Files To: drop-down box and select the desired format. In version 9 you have numerous choices and 

JPG quality options. Which you select depends on how you want the finale images to appear. The 

lower the quality you select, the less space will be used on the drive where your destination file is 

located. Once you have selected the desired format, click OK. The images will begin the process of 

converting. This is an automated feature and it might take a while, depending on the size of the 

TIFFs and the amount of memory available on your computer. When it’s all done, you will have 

multiple JPGs and it will be relatively painless. 

  

Next month: Adobe Photoshop/Elements: A Look at TEXT 

 

*************************************** 

Quick-Tip of the Month for Preservation--Preservation of Precious Documents: Cast Your Net 

Wider 

by Dawne Slater-Putt, CG(sm)* 

*************************************** 

Many times the subject of these “Preservation Tips of the Month” has to do with preserving our 

photographs, documents and other genealogical materials on a personal level. But have you looked 

recently to see what your local and state genealogical societies, historical societies and libraries 

have in the way of digital preservation projects? Maybe some of the items in your personal 

collection can become part of larger efforts. 

 

Here in Allen County, for example, the Allen County Genealogical Society of Indiana (ACGSI) has an 

ongoing project to digitize funeral cards from the local area. In addition to contributions from 

individuals, ACGSI has enlisted the help of two commercial partners in the local funeral industry – 

D.O. McComb & Sons Funeral Homes and Northern Indiana Funeral Care – who have provided 

additional images. This collection includes more than 8,000 images to date. See this effort at 

www.ACGSI.org/funeral/.  

 

One of the digitization projects of The Genealogy Center is the Family Bible Records area of our 

website at www.GenealogyCenter.info/bibles/. The Genealogy Center accepts images of the family 

information pages of bibles from anywhere in the world – and would welcome transcriptions of those 

records to accompany them – and makes them available for free to anyone who visits the site. If 

you have family bible records to contribute, you can email scans (TIFF images preferred) to 

Genealogy@ACPL.info. 

 

The benefits of contributing your materials to these group digitization projects are many: 

*The images reach a larger audience and your images might help someone researching the same 



family. 

*People who are researching your families might make contact with you through your contributions 

and be willing to share information with you. 

*The more elements added to a collection of records, the more value it has to the genealogical 

community as a whole. 

*Seeing the projects grow might motivate others to share the one-of-a-kind materials that they 

have. 

*The wider the distribution of rare records like these, the lower the chance that they will be lost 

to future generations. 

 

Have you checked recently to see if the geographic area where your ancestral families lived has a 

preservation project to which you can contribute?  

 

*“CG” & “Certified Genealogist” are service marks of the Board for Certification of Genealogists, 

and are used by authorized associates following periodic, peer-reviewed competency evaluations. 

Certificate No. 386 awarded 4 July 1996; expires 4 July 2016. 

 

*************************************** 

Ancestor Appreciation Day Poetry Contest Winner 

*************************************** 

The Claiborne County (Kentucky) Genealogy Group, in partnership with poet Stacy Savage, recently 

invited submissions to an Ancestor Appreciation Day Poetry Contest. Ancestor Appreciation Day 

was Friday, September 27, and The Genealogy Center was pleased to post a notification of the 

contest, as well as the winning poem, on its Facebook page, www.facebook.com/GenealogyCenter. 

 

The Genealogy Center is an advocate of writing the stories of your ancestors and the story of your 

own life. For some, writing in rhythm or verse, such as a poem or a song, might be an easier or more 

natural way to express those stories, or it just might be fun to try a different approach! Below is 

the winning poem from the Claiborne County contest.  

 

A Shadow from the Past 

By Marsha Kay Ault 

 

I have never met her, yet I know her. 

I have never seen her, yet I feel her. 

 

Flat cloud base reached up to heaven 

blanketed the entire darkened sky 

the wind howled of yesteryears 

the day I searched for her grave. 

 

The wooden bridge had fallen in 

I parked, walked and walked  

down a red clay road as my heart 

did flip, flops— the storm approached. 

 



A battered pickup rambled toward me 

while beer cans danced in its bed. 

Rifles in a rack reminded me 

I had crossed a “No trespassing” sign. 

 

The wrinkled driver demanded 

why I was on his land, my lips moved 

no memory of what was said 

But the land owner’s demeanor softened. 

 

My body accepted his invite, my head 

pounded with fear as we drove off 

toward my family cemetery 

near his homestead. 

 

The tombstones were in disarray 

broken, tumbled as tall grass, weeds 

hid the stones of little ones robbed of life 

by an unknown fever. 

 

My eyes glimpsed one tall monument 

about four feet tall. The inscription of 

her name reached out all the way to me. 

I found her! My great, great grandmother! 

 

I have never met her, yet I know her. 

I have never seen her, yet I feel her. 

 

*************************************** 

October is Family History Month! 

*************************************** 

Take some time from your busy October to join us in celebrating Family History Month! Check out 

the great schedule of events – there are activities at different times on various days of the week, 

and many days have more than one event planned. Most of these programs are free! All of the 

programs are at the Main Library, in The Genealogy Center or one of the first floor meeting rooms. 

Call 260-421-1225 or email Genealogy@ACPL.Info to register! 

  

Tuesday, October 1, 2013 – 2 to 3 p.m. Meeting Room A 

“What Am I To Do With This?!” A Basic Preservation Presentation on Caring for Family Treasures – 

Curt Witcher  

  

Tuesday, October 1, 2013 – 2 to 3 p.m. The Genealogy Center 

One-on-One Consultations - Space is limited and an appointment is required. Email 

Genealogy@ACPL.Info to schedule a consultation. 

  

Wednesday, October 2, 2013 – 10 a.m.-4 p.m. The Genealogy Center 



Daughters of the American Revolution Research Assistance for Membership 

  

Wednesday, October 2, 2013 – 10 a.m.-4 p.m. The Genealogy Center 

Preserve Your Bible Records Project – Mary Penrose Wayne Chapter of the Daughters of the 

American Revolution 

  

Thursday, October 3, 2013 – 10 to 11 a.m. Meeting Room A 

Introducing the New PERSI – Delia Bourne 

  

Friday, October 4, 2013 – 10 to 11 a.m. Meeting Room A 

Using Interlibrary Loan to Enhance Your Research – Cynthia Theusch 

  

Saturday, October 5, 2013 – 9 a.m. to 1 p.m. Meeting Rooms A&B 

Beginning Genealogy – Margery Graham               

  

Saturday, October 5, 2013 – 10 a.m. to 4 p.m. The Genealogy Center 

Preserve Your Bible Records Project – Mary Penrose Wayne Chapter of the Daughters of the 

American Revolution  

   

Sunday, October 6, 2013 – 1 to 2 p.m. Meeting Room A  

Introduction to DNA for Genealogy – Sara Allen 

  

Monday, October 7, 2013 – 2 to 3 p.m. Meeting Room A  

School Records – Cynthia Theusch 

  

Tuesday, October 8, 2013 – 6:30 to 7:30 p.m. Meeting Room A 

Introducing the New PERSI – Delia Bourne 

  

Wednesday, October 9, 2013 – 6:30 to 8 p.m. Meeting Room C 

Allen County Genealogical Society of Indiana Meeting. Open to the public. 

  

Thursday, October 10, 2013 – 2 to 4 p.m. The Genealogy Center 

One-on-One Consultations – Space is limited and an appointment is required. Email 

Genealogy@ACPL.Info to schedule a consultation. 

  

Thursday, October 10, 2013 – 7 to 9 p.m. Meeting Room B 

African American Genealogical Society of Fort Wayne Meeting. Open to the public. 

  

Friday & Saturday, October 11 & 12, 2013 – 9 a.m. to 4 p.m. Meeting Rooms A&B 

Beyond the Basics – Margery Graham & Steve Myers – Space is limited. Fee. For registration or 

more information, see the brochure at http://www.genealogycenter.org/Events.aspx  

  

Sunday, October 13, 2013 – 1 to 2 p.m. Meeting Room A 

Mapping Fort Wayne and Allen County, Indiana – John Beatty 

  

Monday, October 14, 2013 – 2 to 3 p.m. The Genealogy Center 



Tech Talk I – Delia Bourne – Space is limited. Registration required. Call 260-421-1225 or email 

Genealogy@ACPL.Info. 

  

Tuesday, October 15, 2013 – 2 to 4 p.m. The Genealogy Center 

One-on-One Consultations – Space is limited and an appointment is required. Email 

Genealogy@ACPL.Info to schedule a consultation. 

  

Tuesday, October 15, 2013 – 2 to 3 p.m. Meeting Room A 

How to Look at Your Photographs, Analyze and Organize – Kay Spears 

  

Wednesday, October 16, 2013 – 2 to 3:30 p.m. Meeting Room A 

Writing Your Family History – John Beatty 

  

Wednesday, October 16, 2013 – 7 to 8 p.m. Meeting Room B 

ACGSI Computer Interest Group Meeting. Open to the public. 

  

Thursday, October 17, 2013 – 10 to 11 a.m. Meeting Room A 

Gateway to Your Pre-20th Century Immigrant – Melissa Shimkus 

  

Friday, October 18, 2013 – 10 to 11 a.m. Meeting Room A 

Finding Your Ancestral Homeland – Sara Allen 

  

Saturday, October 19, 2013 – 10 to 11 a.m. The Genealogy Center 

The Genealogy Center Tour – Space is limited. Call 260-421-1225 or email Genealogy@ACPL.Info. 

  

Sunday, October 20, 2013 – 1 to 2 p.m. Meeting Room A 

Introducing the New PERSI – Delia Bourne 

  

Monday, October 21, 2013 – 2 to 3 p.m. The Genealogy Center 

Tech Time II – Delia Bourne – Space is limited. Call 260-421-1225 or email Genealogy@ACPL.Info. 

  

Tuesday, October 22, 2013 – 2 to 3 p.m. Meeting Room A 

Same Name, Same Person? – Dawne  Slater-Putt 

  

Wednesday, October 23, 2013 – 2 to 3 p.m. Meeting Room A 

Allen County in Print – John Beatty 

  

Thursday, October 24, 2013 – 2 to 4 p.m. The Genealogy Center 

One-on-One Consultations – Space is limited and an appointment is required. Email 

Genealogy@ACPL.Info to schedule a consultation. 

  

Thursday, October 24, 2013 – 10 to 11 a.m. Meeting Room A 

Helping Our Families Tell the Stories of Their Lives: Basics of Interviewing – Curt Witcher 

  

Friday, October 25, 2013 – 10 a.m. to 3 p.m. (1 hour break for lunch). Computer Classroom 

Basics of Adobe Elements Workshop – Kay Spears – Space is limited. Call 260-421-1225 or email 



Genealogy@ACPL.Info. 

  

Friday, October 25, 2013 – 6 p.m. – Midnight. The Genealogy Center 

Midnight Madness Extended Research Hours – Must be in The Genealogy Center by 6 p.m. 

  

Saturday, October 26, 2013 – 10 to 11 a.m. Meeting Room A 

Overlooked Records for Hurdling the Census Chasm – Melissa Shimkus 

  

Sunday, October 27, 2013 – 1 to 2 p.m. Meeting Room A 

Making the Best Use of Citations & Notes – Dawne Slater-Putt 

  

Monday, October 28, 2013 – 2 to 3 p.m. Meeting Room A 

Finding Research Facilities Using the Internet – Cynthia Theusch 

  

Tuesday, October 29, 2013 – 2 to 4 p.m. The Genealogy Center 

One-on-One Consultations – Space is limited and an appointment is required. Email 

Genealogy@ACPL.Info to schedule a consultation. 

  

Tuesday, October 29, 2013 – 2 to 3 p.m. Meeting Room A 

Telling Our Story – Melissa Shimkus 

  

Wednesday, October 30, 2013 – 2 to 3 p.m. Meeting Room A 

Beginning Chicago Research – Sara Allen  

  

Thursday, October 31, 2013 – 10 to 11 a.m. Meeting Room A 

Murphy’s Law Applied to Genealogy – Dawne Slater-Putt 

  

For more information about any of these events, see the brochure at 

http://www.genealogycenter.org/Events.aspx. We hope to see you there! 

 

*************************************** 

Keep Warm! Come to WinterTech! 

*************************************** 

WinterTech is The Genealogy Center's way to encourage you to keep your family history research 

skills in shape through the cold (in Indiana) winter months. These programs are held every second 

Wednesday of the month (to coincide with the Allen County Genealogical Society of Indiana's 

monthly meeting), November through February, at 2:30 p.m. 

 

The first WinterTech event is "Take it With You: How to Print or Save Records from Genealogy 

Databases," Wednesday November 13, 2013, 2:30 p.m. to 3:30 p.m. in the Globe Room. After you 

make a great family history discovery in one of The Genealogy Center’s on-site databases such as 

Ancestry or Heritage Quest, you will need to print or save the record for future reference.  Sara 

Allen will lead you on a comprehensive tour through all our databases demonstrating how to take a 

copy of that exciting record with you when you leave.  

 

Future WinterTech classes will include "Researching Indiana Digital Collections," on Wednesday 



December 11, 2013; "'Net Treats" on Wednesday January 8, 2013; and "Apps & Programs for 

Genealogy" on Wednesday February 12, 2014. 

 

Call 260-421-1225 or email Genealogy@ACPL.Info to register for any of these free classes. 

 

*************************************** 

Out and About 

*************************************** 

Curt Witcher 

October 12, 2013 – Wilson-Cobb History & Genealogy Research Library, Roswell Convention Center, 

912 North Main Street, Roswell, NM. Theme: “Mining the Motherlode: Overlooked Genealogical 

Resources.” Topics: 

*Historical Research Methodology: Engaging the Process to Find All the Answers 

*Mining the Mother Lode: Using Periodical Literature 

*Using Church Records in Your Genealogical Research 

*More Than Surname Surfing: Best Practices for Using the Internet for Genealogists 

 

November 2, 2013 – San Mateo County Genealogical Society, Menlo Park LDS Church, 1105 

Valparaiso, Menlo Park, CA. Topics: 

*Mining the Mother Lode: Using Periodical Literature for Genealogical Research” 

*Doing Effective Research In Libraries 

*Doing the History Eliminates the Mystery 

*Fingerprinting Our Families: Using Ancestral Origins As a Genealogical Research Key 

 

John Beatty  

October 2, 2013 – Four Presidents Corners Historical Society meeting, 6:30 p.m., ACPL Monroeville 

Branch. Topic: “General Overview of The Genealogy Center and Its Holdings.” 

 

*************************************** 

Area Calendar of Events 

*************************************** 

Allen County Genealogical Society 

9 October 2013 – ACPL Meeting Room, Fort Wayne, Indiana, 6:30 p.m. Gathering time, followed by 

business meeting and presentation, “Research by Reading Abstracts,” presented by Debbie Muntz. 

  

ACGSI Genealogy Technology Group 

16 October 2013 – ACPL Meeting Room, Fort Wayne, Indiana, 7 p.m. 

 

Chief Richardville House, 5705 Bluffton Road 

5 October 2013—5705 Bluffton Road, Fort Wayne, Indiana, 1-4 p.m. Miami Indian Heritage Days 

featuring the Miami Indian Alliance of Miami Indians (MIAMI) on “Wikiami Building and Cattail 

Matting.” 

 

Allen County History Center 

Through 14 October 2013 – 302 E. Berry St., Fort Wayne, Indiana. Indiana Historical Society’s 

“Auto Indiana” Traveling Exhibit. 



 

Allen County History Center 

6 October 2013, 302 E. Berry St., Fort Wayne, Indiana, 2 p.m. “Battle of Lake Erie” presented by 

Neil O'Brien. 

 

Historic Fort Wayne 

19 October 2013—1201 Spy Run Avenue, Fort Wayne, Indiana, 6:30-10 p..m. “Lantern Tours.” 

 

Historic Fort Wayne 

26-27 October 2013—1201 Spy Run Avenue, Fort Wayne, Indiana, 10 a.m.-7 p.m. Saturday & 10 a.m.-

4 p.m. Sunday. “Camp Allen Muster, 1861-1865.” 

 

*************************************** 

Driving Directions to the Library 

*************************************** 

Wondering how to get to the library?  Our location is 900 Library Plaza, Fort Wayne, Indiana, in the 

block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by 

Wayne Street, and the east by the Library Plaza, formerly Webster Street.  We would enjoy having 

you visit the Genealogy Center. 

 

To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link 

at MapQuest: 

http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Web

ster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1  

 

>From the South 

Exit Interstate 69 at exit 102.  Drive east on Jefferson Boulevard into downtown. Turn left on 

Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard. 

 

Using US 27: 

US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard 

and go five blocks. The Library will be on the right. 

 

>From the North 

Exit Interstate 69 at exit 112.  Drive south on Coldwater Road, which merges into Clinton Street.  

Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks. 

The Library will be on the right. 

 

>From the West 

Using US 30: 

Drive into town on US 30.  US 30 turns into Goshen Ave. which dead-ends at West State Blvd.  

Make an angled left turn onto West State Blvd.  Turn right on Wells Street.  Go south on Wells to 

Wayne Street.  Turn left on Wayne Street.  The Library will be in the second block on the right. 

 

Using US 24: 

After crossing under Interstate 69, follow the same directions as from the South. 



 

>From the East 

Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne.  

You will be on Washington Blvd. when you get into downtown.  Library Plaza will be on the right. 

 

*************************************** 

Parking at the Library 

*************************************** 

At the Library, underground parking can be accessed from Wayne Street. Other library parking 

lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a 

$7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the 

west end of the Great Hall of the Library. Out of county residents may purchase a subscription 

card with proof of identification and residence. The current fee for an Individual Subscription Card 

is $70. 

 

Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two half-

hours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and 

Harrison Street ($3 per day). 

 

Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am – 

5pm, weekdays only.  It is free to park on the street after 5pm and on the weekends. 

 

Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton 

Hotel parking lot that also serves as a day parking garage.  For hourly parking, 7am – 11 pm, charges 

are .50 for the first 45 minutes, then $1.00 per hour.  There is a flat $2.00 fee between 5pm and 

11pm. 

 

*************************************** 

Genealogy Center Queries 

*************************************** 

The Genealogy Center hopes you find this newsletter interesting.  Thank you for subscribing.  We 

cannot, however, answer personal research emails written to the e-zine address.  The department 

houses a Research Center that makes photocopies and conducts research for a fee.   

 

If you have a general question about our collection, or are interested in the Research Center, please 

telephone the library and speak to a librarian who will be glad to answer your general questions or 

send you a research center form.  Our telephone number is 260-421-1225.  If you’d like to email a 

general information question about the department, please email: Genealogy@ACPL.Info. 

 

*************************************** 

Publishing Note:   

*************************************** 

This electronic newsletter is published by the Allen County Public Library's Genealogy Center, and 

is intended to enlighten readers about genealogical research methods as well as inform them about 

the vast resources of the Allen County Public Library.  We welcome the wide distribution of this 

newsletter and encourage readers to forward it to their friends and societies.  All precautions have 



been made to avoid errors.  However, the publisher does not assume any liability to any party for 

any loss or damage caused by errors or omissions, no matter the cause.   

 

To subscribe to “Genealogy Gems,” simply use your browser to go to the website:  

www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be 

notified with a confirmation email. 

 

If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of 

Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe e-

zine" in the subject line.  

 

Dawne Slater-Putt, CG & Curt Witcher, co-editors 


